IT Applications Training & Support

Microsoft Office 365 & OneDrive

MS Office 365 & OneDrive
File Sharing and Collaboration with MS Teams

Revised – 8/22/2019
# MS Office 365 - File Sharing and Collaboration

## CONTENTS

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>What is Office 365?</td>
<td>1</td>
</tr>
<tr>
<td>Who Can Use Office 365?</td>
<td>1</td>
</tr>
<tr>
<td>OneDrive</td>
<td>1</td>
</tr>
<tr>
<td>Your Logon at OneDrive</td>
<td>1</td>
</tr>
<tr>
<td>Logging into OneDrive</td>
<td>1</td>
</tr>
<tr>
<td>Uploading and Downloading Files</td>
<td>2</td>
</tr>
<tr>
<td>Upload Files</td>
<td>2</td>
</tr>
<tr>
<td>Uploading Folders</td>
<td>2</td>
</tr>
<tr>
<td>Downloading Files</td>
<td>2</td>
</tr>
<tr>
<td>File/Folder Management</td>
<td>3</td>
</tr>
<tr>
<td>Creating Folders</td>
<td>3</td>
</tr>
<tr>
<td>Moving Files/Folders</td>
<td>3</td>
</tr>
<tr>
<td>Creating Office 365 Files</td>
<td>4</td>
</tr>
<tr>
<td>Accessing the Office 365 Home Page</td>
<td>4</td>
</tr>
<tr>
<td>Apps</td>
<td>4</td>
</tr>
<tr>
<td>Creating and Editing Word Files</td>
<td>4</td>
</tr>
<tr>
<td>Creating and Editing Excel Files</td>
<td>4</td>
</tr>
<tr>
<td>Creating and Editing PowerPoint Files</td>
<td>4</td>
</tr>
<tr>
<td>Saving Files in Office 365</td>
<td>4</td>
</tr>
<tr>
<td>Working with Office 365 Files</td>
<td>5</td>
</tr>
<tr>
<td>Opening Files in 365 – Word/Excel/PowerPoint Online</td>
<td>5</td>
</tr>
<tr>
<td>Opening Files in Desktop Office – Word/Excel/PowerPoint</td>
<td>5</td>
</tr>
<tr>
<td>Switching Between Office 365 and Local Desktop Office</td>
<td>6</td>
</tr>
<tr>
<td>Switch Between Working with Office 365 and Desktop Office</td>
<td>6</td>
</tr>
<tr>
<td>File Sharing - OneDrive</td>
<td>7</td>
</tr>
<tr>
<td>Share Your File(s) with Others</td>
<td>7</td>
</tr>
<tr>
<td>Edit Share Settings</td>
<td>8</td>
</tr>
<tr>
<td>Edit Share Settings</td>
<td>8</td>
</tr>
<tr>
<td>List Files You’ve Shared with Others</td>
<td>8</td>
</tr>
<tr>
<td>List Files Others Have Shared With You</td>
<td>8</td>
</tr>
<tr>
<td>File Commenting</td>
<td>9</td>
</tr>
<tr>
<td>Adding Comments in Office 365 - Word, Excel and or PowerPoint</td>
<td>9</td>
</tr>
</tbody>
</table>
MS Office 365 - File Sharing and Collaboration

Replied to Comments ........................................................................................................... 9
File Version History .............................................................................................................. 9
Group Collaboration with MS Teams .................................................................................. 10
  Creating a Private Team Site .......................................................................................... 10
  Adding Members .............................................................................................................. 10
  Member Permission Settings .......................................................................................... 10
Joining a Team .................................................................................................................... 11
  Your Logon at teams.microsoft.com ............................................................................. 11
  Responding to an Invite ............................................................................................... 11
Adding Channels/Projects to the Team ........................................................................... 12
  Adding a Channel ......................................................................................................... 12
Conversations ..................................................................................................................... 13
  Start a Conversation ..................................................................................................... 13
  Replying to Conversations ........................................................................................... 13
Files ...................................................................................................................................... 14
  Upload Files .................................................................................................................. 14
  Creating Folders ............................................................................................................ 14
Sharing Individual Files with Non-Team Members ........................................................ 15
Notes – OneNote ................................................................................................................ 16
  Inserting Notes/Content ............................................................................................... 16
  Adding New Pages ....................................................................................................... 16
  Navigating within Pages ............................................................................................. 16
Adding Smartsheets to a Project Channel ..................................................................... 17
  Adding a Smartsheet Tab to a Channel ....................................................................... 17

Support for MS Office 365

You may contact the following office for assistance with MS Office 365:

Training – SBCUSD Training Specialists - techtraining@sbcusd.com - (909) 386-2550

Revisions

1/25/2019 – corrections, minor interface mods
4/11/19 – Added share editing and version history
INTRODUCTION

WHAT IS OFFICE 365?
MS Office 365 is the cloud based version of the popular Microsoft Office. You only need an Internet connected device and a browser in order to use it. It can be accessed with a PC, Mac, desktop, laptop, tablet, or phone – anytime, anywhere. (Yes, it works on Chromebooks.)

WHO CAN USE OFFICE 365?
Every SBCUSD employee. All you need is a District email address. Once you login to Office 365, you can download the full Microsoft Office Desktop Suite for free. You’ll have the full power and functionality of Excel, Word, PowerPoint, and OneDrive.

ONE_DRIVE
OneDrive lets you easily and securely store and share files, videos, documents, and more – anywhere, on any device. Collaborate with Word, Excel, PowerPoint, and OneNote from your desktop or mobile device. OneDrive offers native desktop, browser and mobile experiences on your devices. Access and make changes that sync automatically in the cloud or sync local copies of files for offline viewing and editing on your PC or Mac. Confidently share your files so other people can access them seamlessly and securely.

YOUR LOGON AT ONE_DRIVE
User Name = firstname.lastname@sbcusd.k12.ca.us
Password = SamePasswordAsYourSBCUSDPassword

LOGGING INTO ONE_DRIVE
1. Run a Web Browser (Chrome, Firefox, Etc.).
2. In the Web Address bar, enter the following web address: http://onedrive.com
3. Click on Sign in
4. In the Sign in window enter your email account (firstname.lastname@sbcusd.k12.ca.us)
5. Click on Next
6. Enter your district password (same as your logon here at work)
7. Click on Sign in
UPLOADING AND DOWNLOADING FILES

UPLOAD FILES
1. From within the OneDrive window, click on the Upload button above and choose Files
2. In the Open window, locate the folder maintaining the files you wish to upload
3. Click on a file or hold Control and click on multiple files
4. Click on the Open button

UPLOADING FOLDERS
1. From within the OneDrive window, click on the Upload button above and choose Folder
2. In the Browse For Folder window, locate the folder maintaining the files you wish to upload
3. Click on the folder you wish to upload
4. Click on the Upload button

DOWNLOADING FILES
1. From within the OneDrive window, double-click on folders to navigate to the file wish to download
2. Click on the file icon you wish to download to select the file
3. Click on the Download button above
   OR
1. From within the file’s application, with the file open, click on the file menu and choose Save as
2. Click on Download a Copy
3. Click on the Download button in the Ready window

NOTE – Downloaded files show up in your Downloads folder in Windows Explorer.
OneDrive is the file storage, file management, and sharing application for all your Office files. With OneDrive you can organize, rename, delete, download, upload, and create file sharing/access rights for other file collaborators.

**CREATING FOLDERS**

1. From within the **OneDrive window**, **double-click on folders** to navigate to the folder location where you wish to create a folder.
2. **Click** on the **New button** in upper left and choose **Folder**.
3. In the **Folder window**, **enter a name** for the folder and **click on Create**.

You may create folders within folders in order to maintain the desired folder structure.

**MOVING FILES/FOLDERS**

1. From within the **OneDrive window**, **double-click on the folder** to locate the folder or file you wish to move.
2. **Click** on the **file icon** to select the file.
3. **Click** on the **Move to** button above.
4. In the **Move Panel** at the right, **click on the Your OneDrive button**.
5. **Click** on **folders** to navigate to the folder location you wish to move the folder of file to.
6. **Click on the folder** and **click on the Move here button**.

**IMPORTANT:** In many cases, when managing files and using other OneDrive features, you may need to use the browser’s refresh button in order to confirm these actions.
CREATING OFFICE 365 FILES

ACCESSING THE OFFICE 365 HOME PAGE
1. From within any Office 365 application or location, **click** on the **Application Launcher button** in the upper left and **click** on **Office 365**

APPS
Access the many applications available in the entire Office 365 Suite. OneDrive, Word, Excel, PowerPoint and the Forms application are available and supported in the District.

CREATING AND EDITING WORD FILES
1. **Click** on the **Application Launcher button** and **click** on **Office 365**
2. Under Apps, **click** on the **Word icon**
3. **Click** on the **New Blank document template** or a desired Doc template to begin a new Doc

CREATING AND EDITING EXCEL FILES
4. **Click** on the **Application Launcher button** and **click** on **Office 365**
5. Under Apps, **click** on the **Excel icon**
6. **Click** on the **New Blank workbook template** or a desired Workbook template to begin a new Workbook

CREATING AND EDITING POWERPOINT FILES
1. **Click** on the **Application Launcher button** and **click** on **Office 365**
2. Under Apps, **click** on the **PowerPoint icon**
3. **Click** on the **Blank presentation template** or a desired Presentation template to begin a new Presentation

SAVING FILES IN OFFICE 365
1. In either Word, Excel or PowerPoint, **click** in the **Filename field** at the top of the window
2. **Enter** the desired **file name** and press **Enter**
   
   The file will be saved in the Files root of your OneDrive space. You can easily use OneDrive’s move feature to move the file into another folder if you wish.

**NOTE** – While you enter a name for the file in the Filename field you will not have to periodically save the file with any steps. Office 365 file activity is constantly saved automatically as you work. Changing the file name at any time simply changes the filename. It does not create a copy with a different name. And, It’s shared status is not changed.
WORKING WITH OFFICE 365 FILES

OPENING FILES IN 365 – WORD/EXCEL/POWERPOINT ONLINE

1. From within any Office 365 application or location, **click on the Application Launcher button in the upper left and click on OneDrive**

2. **Double-click on folders to navigate to the folder location where the file resides and click on the file name**
   
   The file will open in its associated online (cloud based) application.

3. **If you see the file but you don’t see the application’s toolbar, click on the Edit Document button in the upper right and choose Edit in Browser**

OPENING FILES IN DESKTOP OFFICE – WORD/EXCEL/POWERPOINT

1. From within any Office 365 application or location, **click on the Application Launcher button in the upper left and click on OneDrive**

2. **Double-click on folders to navigate to the folder location where the file resides and click on the file icon to select the file**

3. **Click on the Open button above and choose Open in Word, Excel, or PowerPoint**
SWITCHING BETWEEN OFFICE 365 AND LOCAL DESKTOP OFFICE

Because Office 365 is cloud and browser based, you’ll notice that the Office 365 applications don’t harbor all of the features that a local installation of the desktop MS Office. However, Office 365 account holders can download a free copy of the desktop MS Office Suite to their desktop or laptop at any time. As a result, you will often edit office documents in 365 and in your local desktop version of MS Office as well.

SWITCH BETWEEN WORKING WITH OFFICE 365 AND DESKTOP OFFICE

1. If and when working with a file online in Office 365 (cloud) and needing to switch to the Desktop Office, click on the Edit in Word/Excel/PowerPoint button.

2. Click on the Office 2016 button.

3. If you are prompted about virus security, click on Yes. Your local desktop version of the application will run and open the file.

4. Make the necessary changes in the local Desktop Office application and click on Save.

5. Close your local desktop version of the file. The file will update with the changes in Office 365 (cloud).

NOTE: Remember there is no auto saving occurring when you are working locally. You’ll need to manage saves when working locally.
FILE SHARING - ONE DRIVE

SHARE YOUR FILE(S) WITH OTHERS

1. From within the OneDrive window, double-click on folders to navigate to the file you wish to share

2. Click on the file icon to select the file

3. Click on the Share button above

OR

4. From within the file you wish to share, click on the Share button in the upper right

5. In the Send Link window, click on Anyone with this link can edit button

6. Click on Specific people

7. Place a checkmark for Allow editing and click on Apply

8. Enter the email address of an SBCUSD team member and press enter

9. Repeat entering more SBCUSD user email addresses for each member you wish to share the file with

10. Add a message if you wish

11. Click on Send

The shared user(s) will receive an email containing a link to the file in question.

NOTE – If you wish to distribute a link to the shared users rather than use an email, click on Copy Link and use any link distribution technique you wish (social media).
EDIT SHARE SETTINGS

1. Click on the file icon to select the file you wish to edit its share settings

2. Click on the Share button above

3. Click on the Triple Dot More Options icon and choose Manage Access

4. Use the Grant Access button above to add further sharees

5. Click on the Down arrow next to a sharee and select Stop Sharing to remove them as a share

LIST FILES YOU’VE SHARED WITH OTHERS

1. From within the OneDrive window, click on Shared in the left panel

2. Click on the Shared by me tab above

LIST FILES OTHERS HAVE SHARED WITH YOU

1. From within the OneDrive window, click on Shared in the left panel

2. Click on the Shared with me tab above
FILE COMMENTING

ADDING COMMENTS IN OFFICE 365 - WORD, EXCEL AND OR POWERPOINT

1. From within an open Office file, place your cursor at a location, highlight a selection, or select an object where you wish to place a comment

2. Click on the Insert menu and choose Comment

3. In the Comments panel at the right, enter a comment for other file collaborators to see in the file

4. Click on the Post button

REPLYING TO COMMENTS

1. Click on the Balloon Comment Icon in Word, Excel and or PowerPoint files

   OR

2. In Excel, click in a cell with a comment icon indicator in it

3. Click on the resulting Balloon Comment icon

4. Click in the reply field in the Comments panel at right, type your reply

5. Click on the Post button

FILE VERSION HISTORY

1. Click on the file icon to select the file you wish to edit it’s share settings

2. Click on the Version history button above

3. In the Version History panel, click on the triple dot icon and select Restore
GROUP COLLABORATION WITH MS TEAMS

Microsoft Teams is a platform that combines workplace conversations, files, and notes. Unlike files in your individual OneDrive account, files in a Team Site belong to a team instead of an individual. The service integrates with Office 365 office productivity suite, including Microsoft Office and features extensions that can integrate with non-Microsoft products (Flow, Forms, Smartsheet and more).

CREATING A PRIVATE TEAM SITE

1. From within any Office 365 application or location, click on the Application Launcher button in the upper left and click on Teams
2. Click on the Teams tab at the left
3. In the lower left, click the Join or create a team button
4. Click on the Create Team button
5. Click on the Staff Members button
6. Enter a name for this site
7. Enter a Description
8. In the Privacy drop-down, select Private – only team owners can add members
9. Click on Next
10. Enter District emails for team members you wish to invite as members to the site and click on Add
11. Click on Close

All invited owners and members will receive an email inviting them to the site.

NOTE: Best practice for a Team is to have at least two owners in the group. This way the Team is not owned solely by one person, who could potentially leave the District.

ADDING MEMBERS

1. To add new members at any time, click on the More Options triple dot icon per the Team you wish to add members
2. Choose Add member
3. Enter District emails for team members you wish to invite as members to the site and click on Add
4. Click on Close

MEMBER PERMISSION SETTINGS

1. In the Team listing at the left, click on the More Options triple dot icon per the Team you wish to manager member permissions
2. Choose Manage team
3. Click on the Settings Tab
4. Click on Member permissions
5. Select which permissions you wish the Site’s team members to carry

NOTE – You may wish to remove the first 5 listed permissions if you wish to remain in control of the scope of Team’s collaborative tools and overall management approach.
JOINING A TEAM

YOUR LOGON AT TEAMS.MICROSOFT.COM
User Name = firstname.lastname@sbcusd.k12.ca.us
Password = SamePasswordAsYourSBCUSDPassword

RESPONDING TO AN INVITE
1. Click on the Open Microsoft Teams button inside the Microsoft Teams email you’ve received

2. Click on the use web app instead button

3. In the Sign in window enter your email account (firstname.lastname@sbcusd.k12.ca.us)

4. Click on Next

5. Enter your district password (same as your logon here at work)

6. Click on Sign in

   Any and all Teams you own or are a member of are listed in the Team Sites panel at the left.
ADDITIONAL TOOLS FOR TEAM MEMBERS

An MS Team maintains a number of light collaboration tools for team members to help them manage projects together. An MS Team can harbor numerous channels (projects). Each individual project channel maintains its own individual instance of those collaboration tools and their data/content.

ADDING A CHANNEL

1. In the Team listing at the left, click on the More Options triple dot icon per the Team you wish to add an individual project channel to.

2. Choose Add channel.

3. Enter a Channel name for the project that team members can collaborate over within this MS Team.

4. Place a check mark on Automatically favorite this channel for the whole team.

5. Click on Add.

A project channel and its collaboration tools are added to the team site.

NOTE – Once you have at least one project channel within the MS Team, you’ll use the collaboration tools in the General channel for “general” group activity. Use the collaboration tools within each individual project channel for collaboration involving that particular channel/project at hand.
CONVERSATIONS

START A CONVERSATION

1. Click on the Team Site you wish to start a conversation in

2. Click on the Channel/Project you wish to start a conversation in

3. Click on the Conversations Tab

4. At the bottom, click in the Start a new conversation field and enter a comment, sentence(s), etcetera, and press enter

   All team members are able to see and/or reply to this entry/conversation upon logging into the Team Site and viewing the channel, and its conversation tab in which this conversation was started.

   **NOTE** – You can begin a comment with the @ symbol and follow it with a team member username and that member will see a comment indicator in the channel you’ve tagged them in, helping them center in on comments directed at them.

   **NOTE** – The Chat tab at the far left allows you to chat privately with anyone in the organization.

REPLYING TO CONVERSATIONS

1. Click on the Team Site you wish to view conversations and/or reply to conversations in

2. Click on the Channel/Project you wish to view conversations and/or reply to conversations in

3. Click on the Conversations tab

4. Click on Reply for any comment in the any conversation you wish to reply to

5. Enter a reply and press enter
**FILES**

**UPLOAD FILES**

1. **Click** on the **Team** and **Channel** you wish to upload files to

2. **Click** on the **Files** tab

3. **Click** on the **Upload** button

4. In the **Open window**, locate the folder maintaining the files you wish to upload

5. **Click** on a **file** or hold control and **click** on multiple **files**

6. **Click** on the **Open** button

   **NOTE** – **Files uploaded to the Files tab are editable by any and all team owners and team members.**

**CREATING FOLDERS**

1. **Click** on the **Team** and **Channel** you wish to create a folder for files

2. **Click** on the **Files** tab

3. **Click** on **folder names** to navigate to the folder location where you wish to create a folder

4. **Click** on the **New button** and choose **Folder**

5. In the **Create a new Folder window, enter a name** for the folder and **click** on **Create**

   You may create folders within folders in order to maintain the desired folder structure.
SHARING INDIVIDUAL FILES WITH NON-TEAM MEMBERS

Team channel files are formally located in the SharePoint arena for that team. You can create individual file shares for non-team members there.

1. From within any Office 365 application or location, click on the Application Launcher button in the upper left and click on SharePoint

2. Click on the SharePoint “Team Site” you wish to share files to non-team members

3. Browse the site’s Document Library (you’ll see it mirrors the team’s channels and their files feature)

4. Select the file you wish to produce a share for a person who is not and should not be a team member

5. Click on the Triple dot icon and Click on Share

6. In the Send Link window, click on Anyone with this link can edit button

7. Click on Specific people

8. Place a checkmark for Allow editing and click on Apply

9. Enter the email address of an SBCUSD team member and press enter

10. Repeat entering more SBCUSD user email addresses for each member you wish to share the file with

11. Add a message if you wish

12. Click on Send

NOTE – The sharee will receive an email with a link to the file or folder shared. Shared folders allow for the sharee to upload files to the folder.
1. **Click** on the **Team** and **Channel** you wish to create note in

2. **Click** on the **Notes tab**

   This is the cloud based version of OneNote.

**INSERTING NOTES/CONTENT**

1. To insert text, **click** on the **Draw** menu

2. **Click** on the **Type button** and **click anywhere** on the page you wish to enter text

   **OR**

3. To insert annotations or free hand drawings, **click** on the **Draw** menu

4. **Click** on the **Pen button** and **click and drag** to draw anywhere on the page

   **OR**

5. To insert images, **click** on the **Insert** menu and **click** on the **Picture** button

6. **Click** on **Choose File**, browse to the image file, select it and **click** on **Open**

7. **Click** on **Insert**

**ADDING NEW PAGES**

1. To insert a new page in the cloud version of OneNote, **click** on the **Insert** menu

2. **Click** on the **New Page** button

3. In the upper left corner of the new page **enter a page name** and press **enter**

**NAVIGATING WITHIN PAGES**

1. If the Notes tab maintains multiple pages, **click** on the **purple arrow** button in the upper left of any page

2. A page menu appears

3. **Click** on the **page** you wish to view and or edit
**ADDING SMARTSHEETS TO A PROJECT CHANNEL**

Team owners who are also Smartsheet project managers can embed Smartsheets into Team Channels allowing team members direct access to Smartsheet project sheets right from within the Team site.

**ADDING A SMARTSHEET TAB TO A CHANNEL**

1. Click on the Plus icon to the right of the channel tabs
2. In the Add a tab window, enter Smartsheet into the search field
3. Click on the Smartsheet icon
4. Click on Install
5. Click on Log in
6. Enter your Smartsheet account credentials and click on Log In
7. Click on Allow
8. Click on Sheets
9. Select the Sheet you wish to embed in this new Smartsheet tab
10. Select Editable by Anyone
11. Place a check mark on Publish this sheet as Editable to Anyone
12. Under Access Control, select Only available to users in the owner’s account
13. Click on Save

You now have a new tab in this channel which harbors the Smartsheet per this channel/project.

14. Right-click on this new Smartsheet tab and choose rename
15. Name the tab Smartsheet and click on Save

**NOTE** – Team members who have been shared to the Smartsheet will have editable access to the sheet right here in the Team site.